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ABR Testing with the RZ6 and Medusa4Z

ABRs - from Set-up to Data Collection

This guide is primarily intended for researchers who are new to collecting ABRs using a TDT

RZ6 system with Medusa4Z preamplifier and BioSigRZ software. It brings together targeted

information  from  our  software  and  hardware  manuals  and  goes  beyond  product  specific

details to answer common questions, including subject or test area considerations that might

affect your testing. The information provided is based on our knowledge of the TDT system

and years of experience helping our users. It is not intended to favor or dictate any particular

experimental protocols, methods, or research goals.

We leave the science up to you, but we are here to support you on your way to successful

experiment completion.

Organization of the Guide

This guide begins with a general overview of ABRs; what they are, how they are used, and what

type of response signal to expect. It discusses the various aspects of your experiment such as

test subjects, your test area, and the hardware and software you will use. It includes detailed

information about important tasks, including:

Running the ABR

Viewing and exporting test results

System calibration

Diagnosing noise issues

Several  appendices  provide  supplemental  information  included  to  provide  supplemental

information on:

Sound chamber setup

Closed field operation

If using the RA4PA/RA4LI instead of the Medusa4Z, see ABR Guide for RZ6 and RA4PA.

Important

• 

• 

• 

• 

• 

• 
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Modifying the stimulus parameters

Conducting noise exposure experiments

ABR Overview

An ABR is a synchronous neural response to an auditory stimulus. ABR testing can be used to

estimate hearing sensitivity.  The ABR is an early  potential,  occurring shortly  after  stimulus

onset, and is typically in the 1 - 2.5 microVolt range, so small that it can be masked by the

background activity of the brain. Because ABRs are repeatable in response to stimuli, signal

averaging can be used to clearly identify the response in recorded data.

A short click or tone stimulus is presented rapidly and response data is collected and averaged

to  reduce  background  noise  and  isolate  the  signal.  Typically,  four  times  as  many  sweeps

averaged together will reduce the background noise by half.

When viewing ABR responses, you can expect to see an averaged waveform trace, consisting

of multiple features with at least two distinct peaks. The response shape should be consistent

but can change in response to changes in the auditory stimulus, such as intensity or polarity.

After averaging, the response should clearly stand out above the noise floor of the system.

Identifying the Threshold

As the level of the stimulus is decreased, the amplitude of the response gets smaller and the

latency gets longer, this makes the biologic features less distinct. The lowest intensity at which

the response is  present  is  generally  considered the hearing threshold  for  the given set  of

variables. The determination of response or no response is left up to the researcher. Because

noise and artifacts can mask the very small threshold response, quiet recordings are critical to

accurate threshold testing.

• 

• 
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Averaged ABR Response Waveforms

ABR Recordings

ABRs  are  a  useful  and  reliable  tool  for  hearing  screening.  To  get  the  clearest  possible

responses, you will need to record using high fidelity equipment in a quiet environment. The

subject must be anesthetized and kept warm to prevent movement or stress from affecting the

response. Recordings should be performed in a shielded enclosure that has been set-up to

minimize noise interferences.

The TDT system for ABR recording is designed to minimize noise at every step, beginning with

an optically isolated, battery powered Medusa4Z preamplifier. This device digitizes the biologic

responses right in the enclosure. The processor (RZ6) brings together stimulus production and

data collection on a single device and a single clock for precise timing. The system software

for experiment control and data visualization is PC based and is more flexible than clinical

systems while still easy to use.

The diagram below shows a typical ABR system. Each part of the system will be discussed in

more detail as you read through this guide.
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Typical System Using TDT's RZ6 Processor and Medusa Preamplifier

What you'll need:

Windows computer (WS4 shown)

Optibit interface (installed in computer)

TDT Drivers (software installed on computer)

BioSigRZ (software installed on computer)

Computer monitor

Multi I/O Processor with optic port (RZ6-A-P1)

Medusa4Z 4-channel amplifier.

Speaker (MF1)

Calibration microphone (PCB-378C01) (not shown)

Needle electrode kit (ELE-N)

Cable kit (BNC-ABR)

Sound attenuating subject enclosure with Faraday cage

Heating pad

Subject

Anesthesia (not shown)

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

11. 

12. 

13. 

14. 

15. 
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The Subject

Planning or setting up your ABR experiment must begin with an understanding of the subject's

normal hearing range and factors that might have an effect on its response or recording. ABRs

have been measured for many species. In this guide, we'll focus on the three most common

species used in ABR experiments and screening protocols: mice, rats, and guinea pigs.

Expected Hearing Range

ABR tests are typically focused on the range in which the species is commonly known to hear

well.

Subject Standard Testing Range Typical Threshold Range

Mice 4 kHz to 32/48 kHz >25 - 30 dB at 16 kHz

Rats >4 kHz to 24/32 kHz >30 dB at 16 kHz

Guinea Pigs >1 kHz to 18 kHz >30 dB at 8 kHz

The hearing range of laboratory subjects may vary across different strains or colonies and can be affected by age,

the environment, and anesthesia.

Note
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Age-Related Effects on Hearing

Many lab subjects experience hearing loss due to age. The rate of loss varies across species

and strains. This effect has been observed as early as 12 weeks in mice.

Anesthesia Considerations

Two types of anesthesia protocols are typically used for ABR testing. Each has benefits and

limitations. Check your IRB approved guidelines for dosages and protocol.

Xylazine(XYL) + Ketamine to start, Ketamine to Boost

This  aesthetic  protocol  uses  an  injectable  combination  of  muscle  relaxer  and  sedative.

Typically,  the subject is unconscious in a few minutes, begins to wake ~45 minutes and is

completely awake at ~90 minutes after initial sedation. If a subject wakes early or a test runs

longer than ~45 minutes, a booster of ketamine can be used to keep the subject anesthetized.

Be sure to follow your approved IRB protocol.

Isoflurane (ISO)

This  aesthetic  protocol  uses  a  fast-acting  inhalant  with  a  short  duration.  The  subject  is

typically fully sedated within 4-5 minutes and wakes very quickly when the gas is removed.
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Your Test Area

The small size (1 uV - 2.5 uV @ 90 dB stimulation) of typical ABR response signals makes it

especially important to minimize electrical noise in the test area and to ensure all conditions

are carefully  controlled during testing.  Be sure to consider  the elements detailed below in

setting up your testing area.

Grounding

Use a designated and grounded electrical outlet.

Enclosure Considerations

Many labs are full of cables, metal structures and other items that generate noise as well as

electrical  wires that  serve as antennas for  electrical  noise.  We recommend using a sound

attenuating chamber with a built in Faraday cage for ABR testing. It is equally important to use

good practices when using the selected enclosure. A mains power cord that extends from

outside the enclosure to inside the enclosure undermines its integrity.

To maintain the integrity of the enclosure:

Keep AC electrically powered devices (wall/mains powered) outside.

Ensure the preamplifier is completely inside your enclosure.

Ensure the preamp charger is unplugged and outside the enclosure.

Ensure electrode wires are completely inside the enclosure.

Verify the enclosure door shuts securely.

• 

• 

• 

• 

• 
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Speaker Placement

Most enclosures have some amount of acoustical reflection or interference during open field

stimulus presentation. The effects will vary depending on the size of the enclosure, the angle

at which the speaker is positioned, and the materials used or added for sound dampening. To

minimize the effects of distortion or interference, position the stimulus speaker on the same

plane as the subject's ear and set at an angle from the sides of the enclosure. See Sound

Chamber Fundamentals for more information on speaker placement.

Vibrations

Vibration from nearby large equipment is another common source of noise. If this is a problem

in your lab, the cage and subject can be positioned on an air table or anti-vibration table.

Heating Pads

When the subject is sedated for testing, it cannot generate enough body heat to maintain core

temperature. When the subject loses body heat, its hearing system is not as responsive which

can  artificially  raise  hearing  thresholds.  A  heating  pad  is  typically  used  to  maintain  the

subject's temperature. Heating pads that require AC power inside the chamber are not suitable

for ABR recordings.

Below are two alternative types of heating pads used for this purpose:

An Isothermal Pad contains a phase change material that changes state near the subject's

body  temperature.  It  can  be  heated  in  a  microwave  and  can  typically  hold  a  constant

temperature for an hour or more.

Example:  https://www.braintreesci.com/temperature-measurement-control/deltaphase-

isothermal-pads/deltaphase-isothermal-pads-8-x-8/

A Warm Water Recirculator moves warm fluid through a small subject heating pad to keep the

subject's body temperatures stable. Because this method uses an external heating element

and  pump  to  transfer  water  to  the  pad  via  non-ferrous  tubes,  the  recordings  will  not  be

affected.

Examples:  https://www.braintreesci.com/temperature-measurement-control/heat-therapy-

pumps-pads/adroit-heat-therapy-pump/ and  https://www.braintreesci.com/temperature-
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measurement-control/heat-therapy-pumps-pads/gaymar-heating-cooling-t-pump-back-in-

stock/

It is critical that you place the heat pump and all associated electrical connections outside the Faraday cage

when using this type of pad.

Important
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The Test Equipment

The care used in setting up your test area must also be taken when selecting and setting up

your test equipment. TDT's ABR system is part of a modular experiment platform. Each module

in the system is designed for exceptional signal fidelity, precise timing, low noise, and ease of

use.

The sub-sections below discuss the role each part  of the system plays in running an ABR

experiment and provides information on making the necessary connections.

Needle Electrodes

In a research environment with non-human subjects, ABRs are typically recorded using sub-

dermal  needle  electrodes.  There  are  a  wide  variety  of  suitable  electrodes  available.  When

working with a TDT System, you will need electrodes with 1.5 mm female safety connectors

(also known as Touch-Proof connectors) to be used with the Medusa4Z. TDT recommends

disposable,  12  mm long,  27  gauge  needle  electrodes  with  18"  color  coded  lead  wires.  In

general,  selecting  the  shortest  available  lead  wires  helps  keep  the  noise  floor  as  low  as

possible.  Some test protocols using small  subjects,  such as mice,  may find that 29 gauge

electrodes are more workable. Keep in mind that smaller gauge electrodes are lighter, but are

also less robust and more likely to dull quickly.
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Medusa4Z BioAmp

Biological  signals  from  the  subject  are  input  to  the  Medusa4Z  for  amplification  and

digitization. The Medusa4Z transfers digitized data to the RZ6 processor via a fiber optic cable.

The fiber optic connection electrically isolates the Medusa4Z from the RZ6 and ensures that

no additional noise is introduced to the biologic signal. This design is intended to be used with

the preamplifier running on battery power alone, placed inside the Faraday cage with only the

fiber optic cable connecting it to the RZ6.

Max Input: ±10 mV max input.

Gain: The Medusa4Z amplifies the signal by 100x before digitizing and transferring it to the

RZ6. The RZ6 automatically accounts for this 100x gain when receiving the data, yielding a net

unity gain.

Power: The Medusa4Z is powered by a Lithium-ion battery. It can be charged in 4-6 hours and

will power the amplifier for up to 30+ hours when using a single active channel.

By default the Medusa4Z will boot up as shown above. A few changes must be made to the

default settings to use for ABRs.

The supplied battery charger must NOT be connected or inside the enclosure when running experiments.  To

protect the battery, do not leave the Medusa4Z on the charger for an extended period of time (1+ week).

Important
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For more information on the Medusa4Z and full system specs, see the System 3 Manual.

Speakers

TDT's MF1 Multi-Field Magnetic Speaker is suitable for testing the hearing range of mice, rats,

and guinea pigs. It can be configured for either free- or closed- field use. See Configuring the

MF1 for  Closed Field Operation.  It  has a built-in  8-32 threaded hole for  use with standard

laboratory  mounting  hardware.  Aluminum  mount/base  fittings  are  included  for  easier

positioning.

Setting Notes

Active Channels Single. We are typically recording from one channel only and this conserves energy.

Sample Freq 12KHz (6KHz). Sampling rate of the Medusa4Z. 12 kHz yields improved signal fidelity in the ABR

signal frequency range.

Impedance Frq 1KHz. This is the frequency used for the built-in electrode impedance tester. 1 kHz is the closest

frequency to the ABR signal frequency range. See Check Impedance for tips and troubleshooting

electrode impedance.

Highpass Filt 3Hz. Built-in highpass filter conditions the signal before it is digitized.

Auto Shutdown Optionally set the Medusa4Z to shut off automatically when not in use. This allow users to run

their normal protocols, and then power off if the user no longer operates the PreAmp. This will

save future users from a dead battery.

Use the POWER button on the top of the Medusa4Z to turn it on and off. There is an ON/OFF (RESET) switch on

the side which completely disconnects the battery and loses all user settings. You should only use the ON/OFF

(RESET) switch if storing the Medusa4Z for an extended period of time.

Caution
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For Open Field experiments, place the speaker 10 cm from the subject. Be sure to position it to

the side of the subject, in line with the ear, NOT in front of the subject.

For more information on the MF1 speakers and full system specs, see the System 3 Manual.

Closed Field Setup

Each MF1 comes with a tapered tip for  Closed Field experiments.  The tip mates with the

provided ⅛" outside diameter (O.D.) PVC tubing (10 cm included). The MF1 comes with an

inline filter (pictured at left) that connects between the RCA cable and speaker input. This filter

should always be in place when using the MF1 speakers in closed-field mode. In closed-field

mode,  the MF1 has undesirably  high low frequency output.  This filter  reduces the speaker

output at low frequencies so that the output range can be equalized. When using the tube tip,

use the MF1's inline filter and the shortest tube possible. You can cut the 10 cm tube to the

desired length. A 3 - 5 cm tube length is typical. The tube should slide snugly into the tube tip.

You can push firmly without fear of damaging the tube. If you have trouble inserting the tube, a

small amount of silicon spray can be used. It may be easiest to spray silicone lightly on a cloth

first then put the tip of the tube on the cloth to apply it.

RZ6 Signal Processor

The RZ6-A-P1 Multi I/O Processor provides the processing power for averaging signal inputs

and the digital-to-analog converters and amplifiers for producing the stimuli. It also provides

the precise timing essential to evoked response experiments.

Other  lubricants  (WD-40,  grease  sprays,  or  similar)  should  not  be  used  as  they  can  damage  the  O-rings

surrounding the tube tip, or the tubes themselves.

Warning
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The power input and optical connection to the PC are located on the back. The input/output

support (such as speaker drivers) and attenuation that is incorporated into the device are all

accessed on the front panel.

Stimulus Output The RZ6's can generate a stimulus in the frequency range of DC - 88 kHz and

is well suited for standard ABR testing.

A built-in stereo power amplifier drives the stimulus signals through TDT's MF1 multi-function

speaker via the BNC labeled Out-A.

Use the RCA cable and BNC to RCA adapter (included with the MF1 kit) to connect OUT-A to

the RCA connector on the speaker.

Attenuation Typically,  stimulus attenuation is handled via software.  The Atten knob on the

front panel provides optional manual attenuation applied to the signal before it is output. This

When using the MF1, the ON/OFF switch next to the outputs marked Electrostatic must be in the OFF position to

reduce noise.

Important
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can be useful if the sound level is found to be systematically too high across all frequencies

during speaker calibration.

Fiber Optic Input Biological signals are digitized on a Medusa4Z preamplifier and transferred

to the RZ6 via the fiber optic port marked 'Optical In'.

Use  the  provided  fiber  optic  pair  (white  connectors)  to  connect  the  To  Base port  on  the

preamplifier to the Optical In port on the RZ6.

The duplex fiber optic cable has identical  one-piece connectors at each end. There is a V-

shaped groove on one side of the connector and a raised rectangle on the other. As shown in

the image above, plug the connector into the RZ6 port with the raised rectangle side up. Plug

the connector into the preamplifier with the V-shaped groove up.

The green LED next to the Optical In port on the RZ6 will illuminate when the preamplifier is

connected and both devices are powered on. This indicates that the Medusa4Z is properly

time-locked with the RZ6.

Mic Inputs The BNC input connector is used during system calibration. See Calibration.
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For more information on the RZ6 and full system specs, see the System 3 Manual.

PC and Interface

The RZ6 must be directly connected to a PC, which provides the user interface for the system.

The PO5 or PO5e optical interface card is installed in the PC and connected to the RZ6 across

fiber optic cables. This adds another layer of noise reduction, separating the processor from

the noisy PC environment.

The PC handles:

Configuring the hardware and software.

Communicating  with  the  TDT  hardware  and  transferring  data  across  a  fiber  optic

interface.

Displaying and working with data during and after acquisition.

If you use TDT's WS4 computer, the optical interface and BioSigRZ software are pre-installed.

If you use your own PC, you'll need to install the interface card and BioSigRZ software yourself.

Step-by-step instructions for installing software and drivers and setting up the processor are

available in System 3 Installation Guide that came with your system. The installation guide also

includes  information  for  connecting  the  WS4  or  your  PC  to  the  RZ6  Processor,  including

running a transfer test to ensure communication between them is working correctly.

• 

• 

• 

A UZ3 (USB 3.0) interface is also available if you wish to use a laptop.

Note
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BioSigRZ Software

BioSigRZ software is streamlined and optimized for ABR and DPOAE screening. The software

provides a simplified interface for  selecting a stimulus and configuring how the biological

response will be recorded and processed.

Typically, ABR experiments use click and/or tone stimuli.

Click ABRs

A click  (square  wave)  is  a  broadband signal  that  stimulates  a

larger frequency range with each stimulus presentation. Because

a wide range of frequencies are stimulated at once, the response

tends  to  be  larger  and  easier  to  identify.  Screening  with  click-

based ABRs also reduces the number of variables to be tested (no individual frequencies) and

thereby  significantly  reduces  the  time  required  to  test  each  subject  (typically  about  5-10

minutes).  Presenting  a  click  stimulus  at  a  few  levels  can  quickly  screen  for  deafness  or

significant hearing loss. Presenting across more levels can provide basic information about a

subject's hearing threshold.
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Tone ABRs

Tone  pips  are  typically  presented  at  multiple  frequencies  to

target more specific areas of the subject's hearing range. Tone

ABRs  take  significantly  longer  to  perform  (typically  up  to

around 40 minutes) but provide more data.

Out-of-the-Box Experiments

When the software is installed, out-of-box experiment files for both types of ABRs are stored at:

C:\TDT\BioSigRZ\Configs\ABR .  The default  values used in the pre-configured experiments

are set to values suited to typical experiments. Your protocol or circumstance may differ from

these values but these will work as an example or a starting point in most cases.

To open the ABR experiment configuration:

Launch BioSigRZ.

Click the File menu and click Open Config. File.

Browse to and open one of the following files:

C:\TDT\BioSigRZ\Configs\ABR\Root_ClickAbr.acf

A  0.1  millisecond,  single-channel  mono-phasic  click  will  be  presented  at  a  rate  of  21

presentations per second. With each successive presentation, the click phase will alternate

between a condensation and rarefaction click to eliminate potential speaker artifacts. Click

1. 

2. 

3. 
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level will vary from 90 dB SPL to 10 dB SPL in 10 dB decrements. A 10 ms response window

is acquired from a single acquisition channel on the preamplifier via the RZ6 fiber optic port.

A total of 512 responses will be averaged at each level.

C:\TDT\BioSigRZ\Configs\ABR\Root_ToneAbr.acf

A five millisecond, single-channel cosine-squared gated tone will be presented 21 times per

second at the following frequencies: 4 kHz, 8 kHz, 16 kHz, 24 kHz and 32 kHz. For each

frequency, the tone level will vary from 90 dB SPL to 20 dB SPL in 10 dB decrements. With

each  successive  presentation,  the  tone  phase  will  alternate  180  degrees  to  eliminate

potential speaker artifacts. A 10 ms response window is acquired from a single acquisition

channel on the preamplifier via the RZ6 fiber optic port. A total of 512 responses will be

averaged at each frequency and level combination.

The Stimulus Settings

The default stimulus settings represent a typical configuration and should be fine to begin, but

you may eventually want to make adjustments.

The stimulus setting dialog boxes can be opened by clicking Setup → Stimulus.
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The setting notes below provide information about each setting.

Setting Notes

Presentation Rate 21/sec (period is 47.619 ms)

Why? This rate minimizes the effects of noise from the 50/60 Hz cycle of mains power --

the most common source of noise interference in research labs. If you change the rate,

make sure the new rate does not divide evenly into 60 or 50.

How does changing the presentation rate affect ABR recordings? Increasing the rate

gives the subject less time to recover between presentations and can decrease the

magnitude of the ABR response.

Stimulus Durations Stimulus duration can be no more than 95% of the period.

CH1 Click.sig or TonePip.sig

When the stimulus is defined, either by loading a standard configuration file or by

specifying a stimulus file (.sig) in the Stimulus Setup dialog, a complete list of signal

parameters and variables are added to the BioSigRZ file. During stimulus presentation,

the values of the variables change as a function of the SigGen Index (SGI), a set of

variable conditions. This is called the stimulus schedule. You can access this schedule

and choose to omit specific SGIs, if desired. See Modifying the Stimulus for more

information on modifying the standard protocol.

Ch1:|Speaker Calibration Leave blank for now

All speakers have some variation in output across frequencies. When you use a speaker

with a known frequency response, you can adjust the stimulus output for these known

frequency characteristics. A USB drive with a speaker-specific calibration file is provided

with your MF1 speaker. You will need to copy that file to the following directory: C:

\TDT\BioSigRZ\TCF . After the file has been copied to this directory you will be able to

select it from a list in the Stimulus Setup. You can also make your own .tcf calibration

file by following the instructions in the BioSigRZ Manual.

The first time you run an ABR, we recommend skipping this step and any other

calibration until after you have been able to successfully record an ABR response. If the

system has not yet been fully tested, small mistakes in calibration can become more

difficult to diagnose. It is important to make sure everything else is working before

calibrating and it is a good idea to start with a click stimulus. Responses to click stimuli

tend to be larger and easier to acquire.
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The Acquisition Settings

The default acquisition settings should be fine to begin, but you may eventually want to make

adjustments.

The acquisition settings dialog boxes can be opened by clicking Setup → Acquisition.

The setting notes below provide information about each setting.
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Setting Notes

Response Record File All the data collected and displayed in the History pane during the ABR test are

stored in a response record file (.arf).

You can specify a name in the setup window or select the Prompt for File Name

check box to be prompted for a name before each recording session. You will be

prompted each time you click Begin.

Duration 10 ms

Important!: The acquisition duration cannot be more than 95% of the presentation

period

Setup Inputs | Chan-1 | Source Medusa4Z

The Bioamp selection determines that the signal will be acquired via the RZ6's

fiber optic input port. The Medusa4Z is used for ABRs.

Also, be sure to set the expected sampling rate to 12 kHz, which is how we

configured the sampling rate of the Medusa4Z in The Test Equipment. This is set

using the drop down menu in the Acquisition Setup screen immediately below the

'Medusa4Z' field.

Number of Averages 512

Why? For most experiments, 512 is a good balance between averaging enough

responses to get good signal quality and few enough to minimize the time to

complete testing. To find the right balance for your experiment, weigh factors such

as length of sedation, purpose of testing (quick deafness screening vs threshold

testing) and number of subjects to be tested. The typical range is 256 -- 1024

averages.

Note: Subjects with hearing loss often require more averages than normal hearing

subjects.

Gain 1

Why and Where? The Medusa4Z amplifies the signal by 100x before digitizing and

transferring it to the RZ6. The RZ6 automatically accounts for this 100x gain when

receiving the data, yielding a net unity gain. The BioSigRZ Acquisition setup gain

should be set to 1x.
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Running the Experiment

After you feel comfortable with the system, you can begin to collect data. We recommend

reading through the entire guide before using a live subject.

Electrode Placement

TDT can provide an electrode kit with suitable needle electrodes for ABR testing. One electrode

is required for each channel, plus one for Ground and one for Reference. The electrodes should

be inserted just  under  the skin and connected to the appropriate  input  on the Medusa4Z.

Correct placement is essential for acquiring good data.

For this single channel configuration, position electrodes as follows:

Channel 1 - Vertex (base of skull)

Reference - Ipsilateral ear (same side as stimulus delivery)

Ground - Contralateral ear (or hind hip or base of tail)
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Check Impedance

The Medusa4Z includes built-in impedance checking. Impedance is a measure of resistance

from electrode to ground. High impedance can result in lower response signals or no signal at

all. After inserting electrodes, run an impedance check for the subject to verify a good insertion

and working electrodes.

To check the impedance level:

Press  the  button  next  to  the  channel  indicator  (e.g.  CHAN-1).  The  impedance  between

channel and ground will be shown on the screen.

Press the REF impedance button to test the reference electrode impedance to ground.

Check Sedation

If  the  subject  is  not  fully  sedated  throughout  testing,  subject  responses,  such  as  muscle

movements or distress,  can interfere with ABR recordings. To avoid this,  always check the

subject before beginning your experiment and monitor the subject for signs of wakefulness

during testing.

Toe Pinch For small lab subjects, a toe pinch is the most effective method to check for full

sedation. Extend the rear leg and use your fingernails to firmly pinch toe or foot webbing. There

should  be  no  recoil.  If  there  is  any  response,  such  as  leg  movement,  the  subject  is  not

adequately anesthetized.

1. 

2. 

The impedance frequency was set in the Medusa4Z Setup options, see The Test Equipment.

Note

The impedance of the input channel (CHAN-1) and the reference (REF) must match, ideally at 1K - 3K for each.

Important

If the impedance is very high (>20 kOhm), it is likely that one of the electrodes is not properly connected. If both

the output channel and reference show high impedance,  it  is likely the ground electrode is not making good

contact.

Tip

Running the Experiment | 28



Begin Experiment

BioSigRZ is the user interface for ABR testing. It has three modes of operation: Idle, Running,

and Averaging. Before you begin, it is in Idle mode. You can begin stimulus presentation or run

the experiment using buttons on the left  side of the BioSigRZ software main window. The

options change depending on the mode. See below for more information about the operating

modes.

To begin stimulus presentation:

Click the Start button. You may be prompted to specify a response record file where data will

be stored.

If prompted, type a name in the File Name field and click Open. You are now in Running

Mode.

The stimulus signal is presented using the first SigGen Index (SGI). No data is collected.

Startling the subject with a loud clap or loud noise is not a rigorous enough way to check sedation. A subject may

not respond to clapping even when only partially sedated. Also, a test subject with hearing loss may not respond

regardless of sedation level.

Note

1. 

2. 
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To begin data averaging:

Click the Begin button.

A Subject Information window opens. Information entered here is stored with the data in the

response record file.

Enter any subject information and click OK. You are now in Averaging Mode.

The first stimulus is repeatedly presented and the ABR response data is acquired and included

in the running average until the desired number of responses has been collected at that level.

As averages are completed, the averaged ABR records will be appended to the History plot and

the .arf data record file.

Modifying the Stimulus Schedule

BioSigRZ provides several functions that allow you to override the current stimulus schedule

and control data averaging in real-time.

Advance Current SGI is halted and running average is saved. Stimulus presentation advances

to the next SGI in the stimulus schedule.

Repeat Current SGI is halted and running average is saved. Stimulus is presented again at the

current SGI.

Skip Current SGI is halted and running average is discarded. Stimulus presentation is advanced

to the next SGI in the stimulus schedule.

Redo Current SGI is halted and running average is discarded. Stimulus is presented again at

the current SGI.

Multi-Purpose Plot

During averaging, the Multi-Purpose Plot may be used to display a variety of signals. The plot is

controlled through the use of the Plot Control Toolbar, available from the right-click menu. You

can also control scaling using the toolbar. Consider using the options described below.

1. 

2. 

3. 
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Running Avg This view displays the current running average.

EEG Plot This view lets you see the last incoming EEG waveform.

The signal displayed is not averaged, so sudden/ temporary anomalies will be visible. If the

waveform jumps, for example, it may indicate that the subject is awake. Other anomalies, such

as heartbeat artifact, can be seen here as well.

Zooming Click and drag from left to right over the area of interest to zoom in and change the

scale of the time axis. Click and drag from right to left to zoom out.

Termination

In BioSgRZ, control of termination of the signal presentation and acquisition is called boundary

control. When a boundary is reached and the SGI stops incrementing, signal generation will

continue for the current SGI, but no more response data will be collected.

To manually terminate data acquisition:

Click the End button.

This returns the system to Running mode. You can halt stimulus presentation and return the

system to Idle mode or run the experiment again.

You can manually terminate data averaging at any time.

Note

• 
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To halt stimulus presentation:

Click Stop.

To run the experiment again:

Click Begin.

Enter the new subject information.

• 

1. 

2. 
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Data and Export

Viewing data in the BioSigRZ plots and worksheet.

History Plot

In  averaging mode,  BioSigRZ acquires data and calculates a running average.  Data will  be

acquired until enough records have been gathered to compute the final averaged signal. At that

time,  the averaged signal  will  be appended to the end of  the History  Plot,  the SGI  will  be

incremented,  a  new  stimulus  signal  will  be  generated  according  to  the  current  stimulus

parameters, and a new average will be computed. This process continues until the termination

of the stimulus schedule is reached or until  you manually  end data averaging.  Information

about each SGI is displayed to the left of the history plot (pictured below). Right-clicking this

data allows you to control what data is shown.
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The Worksheet

The worksheet provides you with several basic functions. It allows you to graphically organize

acquired data and perform mathematical and visualization manipulations of the acquired data

directly in BioSigRZ. The Worksheet is located to the right of the History plot. Waveforms can

be  copied  from  the  Worksheet  and  pasted  to  other  applications  for  report  writing  or  by

choosing to generate a report, you may output data for use by other applications.

To place History Plot records into the Worksheet:

Select the desired record(s).

Click and drag the selected record(s) from the History Plot to the Worksheet.

The selected History Plot record(s) will be copied to the Worksheet.

Export Data

BioSigRZ has many on-board tools for viewing and working with responses. Records may be

exported to an ASCII text file (.txt file) or CSV (spreadsheet) file or you can choose to do further

analysis in an environment such as MATLAB. We can provide support for exporting data to the

desired format, but we leave further analysis up to you so that you can do it your way.

To export to ASCII:

Select the desired records in the History plot.

Or to export all records in the History plot, click the label area at the top of the plot to clear

all selections. When no records are selected, BioSigRZ will prompt to determine if all records

should be exported.

On the Menu bar, click the History menu and click Export to ASCII file.

You will be prompted to supply the export file name and location where the file will be saved.

Click Open.

The selected records will be saved to the new file.

To export to CSV:

Select the desired records in the History plot.

On the Menu bar, click the History menu and click Export to CSV.

1. 

2. 

1. 

2. 

3. 

4. 

1. 

2. 
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To  export  the  trace  data,  check  the  box  next  to  Data  Samples.  If  you  wish  to  further

customize the export, click the check boxes or radio buttons to toggle on/off the desired

options. The settings shown are the typical/ recommended export settings.

Type a report title in the Title field.

Click the Generate Report button.

When prompted, specify a file name and location to store the export file and click the Save

button.

When you are  returned to  the  CSV File  Export  dialog  box,  you can change options  and

generate additional report exports or click Done to exit.

See the BioSigRZ Manual for further information on data viewing tools and export features.

3. 

4. 

5. 

6. 
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Troubleshooting

Determining the Noise Floor

You can determine the environmental noise floor in your environment by running one of the

example ABR tests without the subject present.

To perform a saline test:

Get a small, clean, non-metal beaker (500 mL or similar is fine).

Place all of your electrodes evenly spaced in the beaker.

Tape the electrode wires to the side of the beaker to hold them in place near the bottom,

leaving as much of the electrode exposed as possible.

Fill the beaker with saline enough to cover the electrodes at least 50%.

Put the beaker in the location where the subject would be during ABR recording.

Be sure the speaker  is  in place,  your heating pad is on,  and if  you are using ventilation

equipment, be sure this is running as it would be during an ABR.

Run your ABR experiment normally and collect a series of recordings.

Ideally, your noise floor should be under 100 nV in saline after 512 averages. During a saline

test, the saline replaces the subject, so if the noise floor is significantly higher than expected, it

is likely the noise is environmental.

You can further test your system by removing the electrodes from the saline as noted above

and then insert them in the subject normally following your normal sedation practices. Verify

the subject does not respond to a toe pinch. Disconnect your transducer from the RZ6 and

then start an ABR experiment. It is expected that when you test with the subject, your noise

floor should go up by about 20%. If either of these noise tests don't give the expected results,

please contact TDT Tech Support support@tdt.com.

These simple tests are a good way to identify noise issues before you being collecting data,

they are also good tests to run after any system changes or after the system is moved or

maintained in any way.

If the results show that the noise is not environmental, then it may be an issue related to the

subject, such as sedation or age issues. To confirm this you will need to run an ABR with a live

1. 

2. 

3. 

4. 

5. 

6. 

7. 
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subject and no stimulus presentation. The easiest way to achieve this is to simply disconnect

the speaker. When running this test, the noise floor will typically go up by 20%. If the noise floor

increases by more than 20% the problem is likely subject related (sedatives, etc).

Diagnosing Noise Issues

Electrical  noise  is  one  of  the  most  common problems users  must  address.  Luckily,  most

problems can be resolved easily.

Here are a few common sources of noise:

Always disconnect the preamplifier from the charger and rely on the battery during recordings. No high voltage

lines should be used inside the Faraday cage. Also disconnect the charger from the wall.

See Electrode Placement for correct placement.

Channel 1 and Reference impedances should match at 1K-3K each.

The nearby area should be as free of high voltage noise sources as possible. Common sources are motors, fans,

refrigerators, freezers, lights, and computer monitors.

If your noise floor is higher than expected, we recommend tying the cage to a dedicated ground or connecting it

to a nearby copper pipe, if possible. Use caution if you use an electrical outlet ground. These are commonly tied

to other outlets that could introduce noise.

The charger for the Medusa4Z was left plugged in

Some subject enclosures may include interior lights or fans. These should not be used or connected to

power during ABR recordings.

Note

Ground and reference are placed incorrectly

Electrode impedances do not match

Something near the recording area is causing noise?

The subject enclosure does not have a dedicated ground
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Most electrodes are recommended for one time use. While that is not always practical, electrodes do degrade

with use or time. They can become bent or corroded. Try using another electrode. If the noise disappears, the age

or cleanliness of the problem electrode may have been the culprit.

A low battery state may cause poor recording.

If you have checked the list above and have not been able to identify the source of the noise,

you can perform further testing to narrow down the possibilities.

Troubleshooting On-The-Fly

If a problem occurs during an experiment,  the BioSigRZ Multi-Plot window provides several

views useful  for  on-the-fly troubleshooting.  Here are a few common problems that  can be

identified and resolved quickly so you can resume you're experiment.

BioSigRZ Multi-Plot window

The EEG view allows you to monitor recordings during testing.

Cause: Incorrectly placed electrodes

An electrode is old or has not been adequately cleaned

The Medusa4Z preamplifier battery is at the end of its charge

A heartbeat in the signal
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Cause: An animal that is awake or not fully sedated

You can also view a running average of the ABR responses.

Cause: A speaker problem. Check the speaker by opening the door during an audible frequency or click SGI to

listen for the stimulus.

Cause: A hearing impaired animal. If using a tone, switch to a click to increase the odds of getting a response

(tests over a broad spectrum of frequencies).

Cause: A deaf animal. Try the same test again with a normal hearing animal. 

Cause: A noisy environment. Run a saline test as described above.

Getting Help

If  you  are  unable  to  diagnose  the  noise  problem,  contact  TDT  for  assistance  at

support@tdt.com or +1.386.462.9622.

When  you  contact  us  be  prepared  to  answer  questions  such  as,  what  frequencies  you're

testing, what subject and anesthetic you're using, and when the system was last calibrated. We

may also ask you for data, screenshots, or photos of your experimental setup. We may also

ask you to participate in a remote desktop session, which requires an Internet connection to

your experiment PC running BioSigRZ software.

Random jumps in signal level

No ABR response at any SGI

Noisy signal
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Calibration

All speakers have some variation in output across frequencies. When you use a speaker with a

known frequency response in BioSigRZ, you can adjust the stimulus output for these known

frequency characteristics by selecting your speaker from a list in the Stimulus Setup.

Standard calibration files for common speakers and microphones are provided with BioSigRZ

and a speaker-specific custom calibration file might also have been provided with your speaker

(provided on a USB drive in the speaker kit). If a calibration file is not provided for your specific

speaker  model  or  the  distance  (free-field  experiments)  or  length  of  tube  (closed-field

experiments) is different than those measured for the standard files, you can create a custom

file using BioSigRZ's Calibration tools and a calibration microphone.

The first time you run an ABR, we recommend skipping calibration until after you have been

able to successfully record an ABR response. If the system has not yet been fully tested, using

a custom calibration file can make problems more difficult to diagnose.

How Often to Calibrate

After  your system is set-up and working well,  how often you calibrate is  up to you.  Some

researchers prefer to calibrate every day, others prefer once a week, monthly or longer. If you

are using a robust speaker, like the TDT MF1 magnetic speaker, you may choose to calibrate

less often. If you are using a more specialized speaker, like the TDT EC1 or ES1 electrostatic

speakers,  you may choose to calibrate more often.  If  you are new to collecting ABR data,

consider running a calibration check often enough to confirm that you are seeing less than 5

dB variability, then reducing frequency of calibration to something suitable to your protocol and

experiment conditions. We do recommend calibrating anytime your setup (layout or hardware)

has changed.
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Hardware Setup

To calibrate your system you should have everything set-up as you will have it setup for your

experiment, with the exception of the subject. During calibration you will place a calibration

microphone with a flat response in the band of interest in the place of the subject. The Amp/

BYP switch on the front of the RZ6 must be set in the 'Amp' position, and the Gain knob should

be set to 40 dB to start.

Free-Field Calibration Setup

Closed Field

For a closed field calibration you need to interface your Calibration Microphone to your speaker

tube using some sort of coupler.  Couplers can be made from parts common in most labs

(pictured  below),  such  as  ear  insert  adapters,  syringes,  and  putty.  All  of  the  connections

between the speaker,  tube, coupler and microphone need to be airtight. Any gaps, holes or

other leaks will cause inaccurate calibrations.

Use only one input for channel A at a time. Attempting to input signals from multiple sources will produce an

erroneous signal.

Important

To ensure accurate calibration, give the microphone 10 minutes to warm-up before testing.

Important
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Closed-Field Calibration Setup

Possible coupler materials:

Eartip Putty
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Tone Calibration

During  calibration,  BioSigRZ  performs  a  sweep  over  the  frequency  range  of  interest  and

generates a speaker response curve along with a correction curve that would be required to

flatten the response. An FIR filter is calculated from the correction curve and stored in the

contents of the calibration file. When you load the calibration file, that filter is loaded onto the

RZ6 so that any Tone Pips presented through the RZ6 will be calibrated to have a flat response

across all frequencies.

The extension for calibration files is .tcf. All TCF files should be stored at:

C:\TDT\BioSigRZ\TCF

For more information on file types and calibration see the BioSigRZ Manual.

Click Calibration

The RZ6_Click_Calibration.rcx  circuit is designed to allow you to calibrate the RZ6 for click

stimuli.  This  file  is  part  of  the BioSigRZExamples.zip zipped example folder,  which can be

downloaded from the TDT website. Download and extract the zipped files to:

C:\TDT\BioSigRZ\RCX

To use this circuit there are a few steps required for setup:

Connect your Calibration Microphone to the In-A port on the RZ6.

If your microphone has a sensitivity of less than 50 mV/Pa, ensure your Amp/BYP switch on

the front of the RZ6 is set to Amp.

Connect  your  speaker  to  Out-A  or  Electrostatic-A  (if  using  Electrostatic-A,  be  sure  the

Electrostatic On/Off switch is in the On position).

Place your microphone in the same position that your subject's ear would be located.

1. 

2. 

3. 

4. 
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Launch TDT's RPvdsEx software and open

C:\TDT\BioSigRZ\RCX\RZ6_Click_Calibration.rcx

In the circuit,  double-click the ConstF component labeled Microphone Amplification Level

and set its value to match the Gain knob on your RZ6. Typically 40-60 dB works well, if your

microphone has 1-3 mV/Pa sensitivity. If you are bypassing the amplifier, set the gain in the

circuit to 1.

In  the  circuit,  modify  the  ConstF labeled  Microphone  Calibration  Voltage  to  match  the

sensitivity of your microphone.

To run the circuit:

Click the Compile, Load, and Run button on the tool bar.

Start with a low voltage in the Desired Voltage Amplitude ConstF and slowly increase this

value. Re-compile, load and run (step 8) after you make any modification to the circuit.

When the dBSPL level shown in the top right corner of the screen matches your desired level,

make a note of the voltage you are using in the ConstF labeled Desired Voltage Amplitude.

This voltage and the corresponding dB level should be entered in the click signal stimulus

configuration file found at:

C:\TDT\BioSigRZ\SIG\Click.sig

To open the  SigGenRZ stimulus  design  software  (included  with  BioSigRZ),  click  the

Windows Start menu, click All Programs,  click TDT Sys3,  click SigGen Solutions,  and

then click SigGenRZ.

This program can be used to edit stimulus files.

5. 

6. 

7. 

1. 

2. 

3. 

4. 

a. 
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To open the standard click stimulus file, click File, click Open, browse to:

C:\TDT\BioSigRZ\SIG\Click.sig

Then click Open.

On the main toolbar, click Modify, and then click Signal.

In the Signal Parameters dialog box, enter the voltage and the corresponding dB level in

the Calibration area, and then click OK.

To save the change, click File then Save.

This will save the change to the stimulus used by BioSigRZ's standard click configuration.

Run the stimulus file in BioSigRZ without a calibration (.tcf) file applied to the stimulus. Your

stimulus is already calibrated, and adding a .tcf file will cause the calibration to be incorrect.

b. 

c. 

d. 

5. 

6. 
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See the System 3 Hardware Manual for detailed information on TDT equipment and see the

BioSigRZ Manual for computer requirements and detailed software reference.

Testing Speakers and Microphones

A simple  RPvdsEx test  circuit  can be used to ensure your  speakers  and microphones are

working. The test circuit,  SpeakerMicTest.rcx ,  is part of the BioSigRZExamples.zip zipped

example folder, which can be downloaded from the TDT website.

Speaker Test

If you suspect that your speakers may not be functioning correctly, download and extract the

zipped files to:

C:\TDT\BioSigRZ\RCX

Then double-click the SpeakerMicTest.rcx  file to launch RPvdsEx and open the file.
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To use this circuit there are a few steps required for setup:

Connect your speaker to Out-A.

RZ6 with MF1 Speaker

To test your speaker:

Click the Compile, Load, Run button on the toolbar. You should be able to hear a tone

from the speaker.

Click the Stop button to stop the test.

Microphone Test

After you've confirmed at least one speaker is working, connect the calibration microphone

and run the circuit again.

To use this circuit there are a few steps required for setup:

Connect your Calibration Microphone to the In-A port on the RZ6.

If your microphone has a sensitivity of less than 50 mV/Pa, ensure your Amp/BYP switch on

the front of the RZ6 is set to Amp.

Place your microphone where your subject's ear would be located.

1. 

To ensure accurate calibration, give the microphone 10 minutes to warm-up before testing.

Important

1. 

2. 

3. 
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RZ6 Open Field Calibration Setup
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You should be able to see a sine wave in the graph. You may need to adjust the scale using the

green arrows on the sides of the graph. Click the Stop button again to stop the test.
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Sound Chamber Fundamentals

Reflections and interference inside of a sound chamber can distort the stimulus frequency or

have  an  undesirable  effect  on  the  stimulus  level.  This  section  provides  supplemental

information on these issues and correctly setting-up your sound chamber.

Reflections and Interference

Sound waves are a mechanical force in which pressure is used to transmit energy through a

physical medium. Sound waves can be reflected off surfaces. The reflected signal strength is

based on the angle of incidence and damping factor of the reflecting surface.

Figure 1 - Sound wave reflection vectors inside a sound chamber

Constructive & Destructive Interference

The signal strength at a specific point of interest (e.g subject's ear,  calibration microphone

location) can increase or decrease depending on the phase delay, frequency, distance of travel

and damping factor of the material.

For this reason, the measured dB SPL of a specific frequency may vary greatly depending on

the combination of the primary signal and its reflections at the recording site, which may

appear as drop outs or spikes in the calibrated frequency response for your speaker.
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Figure 2 - The summation of signals during constructive interference (left), partial interference (middle), and

fully destructive interference (right). The level of interference is based on the frequency-specific phase delay,

which is based on wavelength and distance of travel for the primary and reflected signals.

Figure 3 - A standing wave that is present at the subject's ear when the reflection returns

Constructive and destructive interference is caused by standing waves and their reflections. In

the  model  configuration  above,  with  a  speaker-subject  distance  of  10  cm,  a  subject-wall

distance of 30 cm, and a reflective distance of 70 cm, any stimulus longer than 0.175 ms will

generate a temporary standing wave.

The table below shows speaker position offset tolerances with respect to frequency. It further

emphasizes how reflections can affect standing waves and tone pips at various frequencies.

The ∆ value is the relative distance or tolerance between fully constructive and fully destructive

interference. This value represents a 180° phase shift over a reflected distance or λ/4. The

speaker-subject  spacing  and  tolerance  is  very  sensitive  to  change,  especially  at  higher

frequencies.  If  a  speaker's  position  is  displaced  by  a  distance  of  2.68  mm,  for  a  32  kHz

stimulus, the reflection's phase is shifted 180° and could greatly reduce the perceived intensity.
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Ways to Reduce Reflections and Interference

To reduce reflections and interference:

Increase the distance of travel for the reflections by changing the angle of incidence. If the

angle of incidence is near a corner but not focused directly at a corner, the reflections will

bounce off both walls and scatter throughout your chamber rather than bounce off one wall

before converging at the center of the chamber.

Increase the damping factor by covering hard surfaces (metal, tile, wood, plastic, etc.) with

soft, spongy, non-reflective, sound absorbing materials (carpet, foam, etc.).

Figure 4 - A sound chamber used for testing and calibrating speakers

The walls and table top in Figure 4 are covered by 1 inch foam pads with 1 inch tall pyramid

projections (total thickness of 2 inches) for increased scattering.

c (m/s) f (Hz) λ (mm) ∆ (mm)

- - c/f λ/4

343.2 4000 85.8 21.45

343.2 8000 42.9 10.725

343.2 16000 21.45 5.3625

343.2 32000 10.725 2.68125

1. 

2. 
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Figure 5 - An example of a good sound chamber

The  floor  and  walls  in  Figure  5  are  covered  in  soft,  absorbing  surfaces  (1.75  inch  foam

padding) with significant damping power. The speaker and subject are aligned slightly off-axis

with the wall to maximize scattering.

Figure 6 - An example of a bad sound chamber

The speaker orientation in Figure 6 is an example of poor sound chamber preparation for two

reasons.  First,  the speaker  is  angled directly  at  the floor,  so the stimulus will  be reflected

The external shell is metallic and tied to earth ground, which doubles as a Faraday cage that will shield against

electromagnetic radiation.

Important

Sound Chamber Fundamentals | 53



directly back into the subject's ear. Second, the floor is a hard reflective surface that offers little

to no damping.

Figure 7 - An example of a bad sound chamber.

Figure 7 is also incorrect because the speaker is aligned orthogonal to the wall, which also

provides a direct reflective path back to the subject's ear.  In both cases, depending on the

exact  distance  of  travel,  the  reflections  will  accumulate  at  the  subject's  ear  to  create

constructive or destructive interference, which will distort the stimulus and give an undesired

sound pressure level.
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Configuring MF1 for Closed Field

MF1 Closed Field Speaker Assembly Diagram

To configure the MF1 for closed field operation:

Ensure Black O-ring is in place on back of CF Adapter, as shown.

Closed Field Adapter, Tip, and CF Line Filter used only for Closed Field Configuration!

Important

1. 

Front of Speaker Back of CF Adapter
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Attach the CF Adapter to the front of the speaker using three of the provided ¼ x 4-40 hex

screws.

Ensure the blue O-ring is in place at the base of the desired tip, as shown.

Insert the tip into the groove on the CF adapter. Ensure the tip is bottomed in its socket.

Gently insert the tube into the narrow end of the tip.

Attach the CF filter to the provided RCA cable.

CF Line Filter

Attach a BNC to RCA adapter to the BNC amplifier port of your source device.

2. 

Speaker with CF Adapter 3 mm Tube Tip with Blue O-Ring

3. 

4. 

For Closed Field Configuration Only

Important

5. 
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Back of Speaker (shown with included stand)

Connect the MF1 to the amplifier using the RCA cable (with CF filter attached).

For more information on the MF1 Speaker, see the System 3 Manual.

6. 

Configuring MF1 for Closed Field | 57

https://www.tdt.com/docs/hardware/mf1-multi-field-magnetic-speakers/


Modifying the Stimulus

When the stimulus is defined, a complete list of signal parameters and variables are added to

the  BioSigRZ  file.  During  stimulus  presentation,  the  values  of  the  variables  change  as  a

function of the SGI. This is called the stimulus schedule.

You  may  wish  to  present  a  subset  of  the  current  stimulus  schedule.  Both  the  stimulus

schedule  and  the  variable  definitions  can  be  modified  in  BioSigRZ.  To  do  so,  display  the

stimulus  schedule  (as  below)  then  select  the  SGIs  to  be  included  in  the  subset  for

presentation.

To view the current stimulus schedule:

Select Modify Schedule from the Operations menu.

Or select SigGen Variables from the Setup menu.

Or click the Modify Schedule button.

• 

• 

• 
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The SigGen Variable Control dialog displays the current stimulus schedule. Variable values are

shown for each SGI. Select SGIs to include in signal presentation by using standard Windows

techniques, such as click, SHIFT-click, and CTRL-click. You can also choose to 'Do Odd' or 'Do

Even', using buttons in the dialog box. When no SGIs are selected, BioSigRZ will present the

entire stimulus schedule. Otherwise, BioSigRZ will present only the selected SGIs.

Modifying Variables

The variables can also be modified to meet your needs.

To modify a variable:

Click the variable button for the desired variable, such as Freq.

In the Signal Variable dialog box, make any changes then click OK to confirm and return to

the SigGen Variable Control.

Different variables may have different editable options. For example, the variable frequency

for a tone stimulus may be configured by entering a Value List (shown below). For a click

stimulus, the Phase may be configured using an Alternating variable method.

1. 

2. 
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Another commonly modified variable is the Gate Time for tone stimuli.  Typical ABR gate

times are 0.2 ms - 2 ms.

Changing the gate time will change the size and shape of the response.

Note

The changes will only be saved in the configuration file, if the Lock SigGen Files check box is selected in the

Stimulus Setup dialog bog. If  this check box is not selected,  any changes to variables or SGI selections for

presentation will be lost.

Also, if you select the Reload Files button in the Stimulus Channel Setup window, the changes will be overwritten

in favor of the values in the .sig file.

Important
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The schedule tool was designed for quick edits you may want to make while testing or setting

up a new paradigm. For permanent edits to your stimulus, TDT recommends using SigGenRZ

(included with BioSigRZ installations) to modify the stimulus files (.sig) directly.

Customizing the Stimulus

SigGenRZ is a signal design software that enables you to create stimuli in a dialog box driven

environment.  Most  importantly,  it  allows  most  settings  to  be  used  as  variables  for  your

experiments. All of the signals used in the BioSigRZ out-of-the- box experiment configurations

have been created in SigGenRZ. It is also a helpful tool for modifying aspects of the stimulus

that are not editable from within BioSigRZ.

To modify a file directly in the SigGenRZ software you will need to follow these basic steps:

Open the stimulus file (.sig) in SigGenRZ.

Make changes in the file.

Save the file or save the file with a new name.

Open the desired BioSigRZ configuration file (.acf).

Load or reload the stimulus file.

Save the BioSigRZ configuration file.

Opening the File

The stimulus files (.sig) for the BioSigRZ out-of-the-box experiment configuration are stored at:

C:/TDT/BioSigRZ/SIG/

For ABRs, there is one file for click stimuli and one for tone stimuli: Click.sig and TonePip.sig,

respectively.

It is generally a good idea to leave the original files unchanged and in place, but you can still

use and modify these files then rename the file.

To open the signal file you wish to modify:

Click the Start button on the Windows taskbar, point to Programs, point to TDT Sys 3, and

click SigGenRZ.

Select Open from the File menu.

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 
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Click the desired file name.

Click OK.

To save the file with a new name:

Select the signal by clicking anywhere in the signal window.

Choose Save As from the File menu.

The Save As dialog box will be displayed.

Type a new name for the signal and click OK.

SigGenRZ builds a signal from mini-signals called segments. The standard ABR stimuli have

only one segment. Some settings affect the entire signal while others affect only a segment.

The  most  common  changes  to  the  signal  settings  include  Timing  Duration and,  for  click

calibration,  Calibration  Level and  Attenuation  Level.  These  can  be  found  in  the  Signal

Parameters dialog box.

To open the Signal Parameters dialog box:

Click Signal from the Modify menu.

The most common changes to the segment parameters include: Gate Type,  Gate Time and

Duration.  Parameter  settings  that  define  the  segment  can  be  modified  in  the  Edit  Signal

Segments window.

To access the Edit Signal Segment window:

Select Modify → Segment menu option in the main window.

Or double-click the segment marker in the signal window.

3. 

4. 

1. 

2. 

3. 

4. 

• 

• 

• 
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In  the  Edit  Signal  Segment  window,  you'll  find  a  variety  of  Windowing/Gating  and  other

parameters.

Gate Type

From the Gate Type box, you can select a variety of gating or windowing functions, including:

Cos2 (10% - 90%)

Ramp

Blackman

Hanning

For tone pips, Cos2 is the default setting. For click stimuli, gating is not necessary and the Gate

Type should be set to None. 

• 

• 

• 

• 
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Suggested Stimulus File Changes

In  SigGenRZ,  we  supply  a  tone  example  called  TonePip.sig.  For  mouse  models,  most

customers like this as a starting point with two edits: 

Most  mouse  researchers  find  that  the  best  responses  are achieved  with  a  2-4  ms

stimulus. A 2.5 ms duration is most commonly used. Make this change as shown below

in red. Click on the Duration variable and change the Default/Start from 5 to 2.5, then

click OK. 

Most mouse researchers find that the best responses are achieved with a 0.2 to 0.8 ms

gate time. A 0.2 ms gate is most commonly used. Make this change as shown below in

orange. Click on the Gate Time variable and change the Default/Start from 2 to .2, then

click OK. 

We  recommend  saving  this  resulting  tone  pip  with  a  new  name,  such  as

"Mouse_TonePip.sig" or similar.

Going  back  to  BioSigRZ,  you  must  open  your  .acf  file  made  in  the  previous  section

("Template_ToneABR.acf"). Click on Setup → Stimulus → Ch1, then change the Primary file

from "TonePip" to the new file ("Mouse_TonePip.sig") by pressing the browse button and

selecting the new file (see below circled in red). Click OK, and then OK again and then save

the resulting file as "Template_ToneABR.acf" or similar as discussed in the previous section.

1. 

a. 

b. 

c. 

2. 
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Wrapping up

Before running any subjects with any ABR system, we recommend running a saline test. Only

when the saline test looks good should you proceed to test with a subject. 
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Noise Exposure

ABR testing is a common method used to investigate the link between noise exposure and

hearing loss. As a result, some of our customers have asked for more information on using

their  TDT system for  implementing  noise exposure  in  the lab.  This  section includes basic

information on noise delivery and our best advice for lab set up. For investigators new to noise

exposure experiments, we also recommend consulting other researchers with experience in

the field.

Noise exposure testing typically compares the results of hearing measurements before and

after exposure. The goal of noise exposure delivery in the lab is to reproduce or simulate the

effects, including hearing damage or deafening, of real-world noise exposure.

Key elements of noise exposure:

High dB noise delivery

Extended duration (hours) of continuous sound delivery

Filtered or unfiltered noise

Hardware Requirements:

TDT Signal Processor, such as the RZ6 Auditory Processor

Amplifier

Speaker

Microphone and microphone amplifier (for calibration and testing enclosure)

PC for experiment control

When considering your hardware set-up, the first question to ask is what level sound you will

be using. The TDT amplifiers and speakers are not intended for delivering sound greater than

1. 

2. 

3. 

Tones can also be used to investigate frequency-specific hearing loss

Note

1. 

2. 

3. 

4. 

5. 
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100 dB over  long periods,  typical  of  most  noise exposure protocols.  That  type of  use will

damage the speaker and will almost certainly result in clipping the stimulus. We suggest using

an external amplifier and speakers.

External Amplifiers

You  might  already  have  an  appropriate  amplifier  in  your  lab.  One  of  the  most  common

amplifiers we have seen in labs is the Crown D-75 or Crown D-75A. Unfortunately, this is no

longer available. If you have one, this is a good choice. If you don't already have a suitable

amplifier, we can recommend the CSA 280Z manufactured by JBL (formerly Crown). The CSA

280Z is a two-channel amplifier that provides up to 80 watts of power.

Speakers

Because  speaker  models  change  frequently,  it  is  difficult  for  us  to  recommend a  specific

speaker. A commonly available three-way, 6 inch by 9 inch car speaker is a good choice for

delivering sound.

Setting Up Signal Generation in RPvdsEx

All of the tasks performed by your RZ6 are configured via Real-time Processor Visual Design

Studio,  RPvdsEx,  files.  BioSigRZ and  all  other  TDT software  use  RPvdsEx  files  behind  the

scenes to control TDT hardware. You will use this same software to deliver noise exposure.

The  RPvdsEx  is  a  nuts  and  bolts  tool  with  virtually  limitless  flexibility,  but  it  wasn't  really

designed for running experiments. That means the user interface will look a little different from

our applications software. For this purpose, however, it will work just fine and all you will need

to do when it is time to start signal presentation is open a file and click run.

Before you run signal presentation, however, you will need to make some basic adjustments to

the file.

TDT has three versions of a basic timed sound presentation file:

Noise Exposure | 67

https://jblcommercialproducts.com/en-US/products/csa-240z-280z-2120z


These files are included in the BioSigRZ Examples folder found at:

https://www.tdt.com/files/examples/BioSigRZExamples.zip

After you have downloaded and extracted the folder, choose the file that is right for you and

double-click it to run RPvdsEx and open the file.

Modifying the RPvdsEx File

The  processing  functions  that  make  up  this  task  appear  as  components  ordered  and

connected in the processing chain and arranged on a large sheet.

You can use the Pan button or the horizontal and vertical scroll bars to move around the

sheet. The illustration below shows the circuit and identifies the tasks in each section.

Stimulus Type Circuit Name

Filtered Noise RZ6_TimedNoise_Calibrated.rcx

Unfiltered Noise RZ6_TimedNoise_Calibrated_NoFilter.rcx

Tone RZ6_TimedTone_Calibrated.rcx
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Random Noise Generation Circuit

Working with Circuit Components

This circuit is configured for you, but you will need to change the properties of some of the

components.
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Circuit Segment

To modify  the  properties  of  any  component,  double-click  it  and  enter  a  new value  in  the

properties dialog that is displayed and then click OK.

To create a link, double-click an output port on a component, then click the input port on the

next component in the circuit.

To add a component, double-click the workspace and select a component.

To delete a component or link, click it and press the DELETE key on your keyboard.

For more information on working with circuits, see the RPvdsEx Manual.

Modify a File

Open the appropriate RPvdsEx file.

If you are using filtered noise, the first step is setting the filter values. If not, you can skip to

the next step.

Find section B, in the illustration above. By default the circuit uses a lowpass filter with a

corner frequency at 16 kHz and a highpass filter with a corner frequency at 8 kHz.

1. 

2. 
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These components generate the filter  coefficients used by the Biquad filters.  To set  the

filters, modify the corner frequencies (Fc) in the ButCoef components as needed.

The TDT System outputs a voltage. To ensures the output voltage is calculated correctly for

the desired dB results, you need to calibrate the system.

Find section C, in the illustration above. The voltage is set in the circuit segment pictured

below. By default, it is set to 1.3 V, which should be a good starting point. For now, leave the

default voltage as is.

The expected dB SPL is displayed for reference. The actual dB will depend on your complete

system, including the external amplifier and speaker.

To begin calibration, place the calibration microphone in the subject enclosure in place of

the subject. We recommend the PCB-378C01 PCB microphone and mic amplifier.

Enter the microphone sensitivity for your calibration microphone. Find this circuit segment

pictured below.

3. 

4. 
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Double-click  the  first  ConstF  component  and  enter  the  microphone  amplification  level

indicated by the microphone Gain knob setting on the face of the RZ6. Click OK.

Using the microphone sensitivity provided by the manufacturer,  determine the calibration

microphone voltage (usually listed on spec sheet in millivolts per Pascal). Double-click the

second ConstF component and enter the value in volts. Click OK.

Section B of the circuit, calculates the dB SPL. You shouldn't need to make any changes in

this segment, but this a good time to save the circuit with a new name.

To run the circuit for calibration:

To begin calibration, make sure the microphone is in place and the chamber is closed,

then click the Compile, load, run button on the main toolbar.

To stop presenting the sound, click the Stop button.

To restart, press the Run button.

Use the level recorded by the microphone to adjust the voltage.

To update to the corrected voltage, locate the DataTable component pictured here.

Click the green up or down arrows to adjust the value.

If none of the preset values is suitable, you can double-click the DataTable component to

modify the table.

The microphone amplification switch on the RZ6 front panel must be set to AMP.

Important

5. 

Both Run and Compile, Load, Run restart the presentation, however, Compile Load, Run also restarts the circuit

timer. Run resumes from current value in timer.

Note

1. 
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Set desired duration, in minutes.

Double-click the iCompare component labeled "set duration here" and enter a value for K

equal to the desired number of minutes you want the signal to play. For example, k = 120 for

a two hour presentation. Click OK.

Save the changes you've made. Be sure the file is saved using a new name.

To run the circuit for presentation:

To begin, click the Compile, load, run button on the main toolbar.

To stop presenting the sound, click the Stop button.

Using Tones

If you are using the timed tone signal file, you will need to set the tone frequency. Find the

section of the file pictured below.

TDT devices are limited to ±10 V. If the calibration results in a voltage outside this range, your stimulus will be

clipped and distorted. If this becomes and problem, you need a more sensitive speaker or a more powerful

amplifier.

Important

2. 

3. 
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To set the tone frequency:

Double-click the ConstF component, set the desired frequency in Hz, and click OK. Then

run the circuit as explained above.

Preparing a Suitable Enclosure

Noise exposure is performed inside a chamber to protect the researcher's hearing. You will

also need an enclosure inside the chamber to limit the movements of the agitated subject and

ensure it is positioned near the speaker. If you do not already have a suitable animal enclosure,

you  can  build  one  from  widely  available  materials.  This  section  provides  general

recommendations for your chamber and enclosure.

Soundproof the Chamber

Line the inside of the chamber with acoustic foam to eliminate constructive or destructive

interference with the signal. See Sound Chamber Fundamentals for more information.

Build the Enclosure

Use  mesh  hardware  cloth  to  create  an  oval  tube  or  cylinder  with  a  maximum  width  that

matches your selected speaker. Mesh hardware does not interfere with noise moving through

the chamber but will resist the subject's attempts to escape the space and be strong enough to

support the weight of a speaker placed at the top of the tube.

Use mesh hardware cloth to create a raised floor a few inches above the acoustic foam and a

lowered ceiling a few inches below the speaker. This will prevent the subject from damaging

the acoustic foam or the speaker in any attempt to escape the space.

• 
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Protect Foam with Replaceable Underpad

Place a blue disposable underpad on the acoustic foam below the tube to collect droppings

and prevent damage to the foam.

Position the Speaker

Position the speaker directly above the tube, facing down toward the subject.

Completed Enclosure with Subject

Ensure Consistent Signal Delivery

After you build the enclosure, verify that SPL at all test levels or frequencies is even across all

spaces in the enclosure.
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Working with Multiple Subjects

If you need to expose more than one subject at a time, you can use mesh hardware cloth to

divide the tube into four equal  size enclosures.  The smaller  space may also help limit  the

subject's movements and agitation.

For  more than four  subjects,  add a  second tube and speaker  in  the  enclosure  and add a

second channel to the RPvdsEx circuit file.

To add a second channel:

Open the RPvdsEx file.

Find the RZ6_AudioOut macro component pictured below. Double-click the component to

display the properties.

On the Setup tab, change Disable Channel B to No, and click Done.

To route the signal to channel B, double-click the teal output port of the Biquad filter that

precedes the RZ6_AudioOut then click the teal input port for DAC-B.

1. 

2. 

3. 

4. 
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Be sure to save your changes.

Connect the second output of your RZ6 to a second external amplifier and speaker.

5. 
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Upgrading from RA4PA to Medusa4Z

Hardware Setup

Unlike the older RA4PA/RA4LI combination,  the Medusa4Z must be setup before it  can be

used. To do this: 

There is a recessed On/Off switch on the side of the Medusa4Z shown below with the red

arrow. This must be in the On position for use. Under normal operation this switch should

not be used (that it why it is recessed) because when you turn it to the Off position, the

Medusa4Z will also reset all of the settings to their defaults. For normal operation, the Power

button on the top of the Medusa4Z should be used. This is shown below with the green

arrow.

With the Medusa4Z powered on, and at the main screen, press the Setup button once. This

will bring you to the Active Channels screen. For a normal ABR this should be set to Single.

You can toggle through the options with the Option button. 

With the Medusa4Z powered on, and at the main screen, press the Setup button twice. This

will bring you to the Sample Freq screen. For a normal ABR this should be set to the 12 kHz

mode. Pressing the Option button allows you to toggle through the options. 

With the Medusa4Z powered on, and at the main screen, press the Setup button three times.

This will bring you to the Impedance Frq screen. For a normal ABR this should be set to the 1

kHz mode. Pressing the Option button allows you to toggle through the options. 

With the Medusa4Z powered on, and at the main screen, press the Setup button four times.

This will bring you to the Highpass Filter screen. For a normal ABR this should be set to the 1

Hz mode. Pressing the Option button allows you to toggle through the options.

With the Medusa4Z powered on, and at the main screen, press the Setup button five times.

This will  bring you to the Auto Shutdown screen. This is an optional feature that can be

disabled if the user wants, however, we recommend the 3 hour setting. In the case of a long

1. 

2. 

3. 

4. 

5. 

6. 
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ABR paradigm, the 1 hour setting may be too short and the PreAmp may shut off while the

experiment is ongoing. Setting this to 5 Hours or Never can result in unnecessary battery

drain. Pressing the Option button allows you to toggle through the options.

The  shutdown  counter  resets  any  time  the  user  presses  any  button  on  the  top  of  the

Medusa4Z. For example, when they check the impedance of their next subject the counter

will reset.

With  the  Medusa4Z  and  the  RZ6  turned  on  and  connected  to  each  other,  look  at  the

Medusa4Z main screen. You want to see Med4Z in the top left corner. If you see NoOpt! This

indicates an optical failure between the RZ6 and the Medusa4Z.

With  the  Medusa4Z  and  the  RZ6  turned  on  and  connected  to  each  other,  look  at  the

Medusa4Z main screen. You will  notice a battery icon and a battery life indicator with a

percentage on the top right corner. I recommend not starting an ABR with less than 20%

battery life remaining. The Medusa4Z will charge from dead to 90% in only 4 hours with the

included charger. Other chargers may be used (up to 12 volts) but the charge time may be

reduced. 

The 1.5 mm touchproof connectors that are also on the RA4PA/RA4LI will  work with the

Medusa4Z.  Nothing  has  changed  regarding  the  recommended  electrode  locations,  CH1

should be at the vertex, GND should be at the contralateral mastoid, REF should be at the

ipsilateral mastoid. For a normal ABR, CH2, CH3, and CH4 will be unused. 

With the setup outlined above complete, you can now check the REF and CH1 impedance by

pressing the REF and Chan-1 buttons on the top of the Medusa4Z. In a mouse model with

needle electrodes, you should see an impedance values of approximately 1k. Slightly higher/

lower  isn’t  a  problem  as  long  as  your  REF  and  CH1  impedances  match  each  other.  I

recommend reseating or  replacing the electrodes if  the impedances are more than 20%

apart from each other. 

7. 

8. 

9. 

10. 
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Software Updates

In order to use the Medusa4Z you must have the TDT Drivers,  BioSigRZ, and all  other TDT

software at least at v95. Updates are available on our Downloads page if you find anything is

out of date. 

Hardware Updates

In order to use the Medusa4Z your RZ6 microcode must match your BioSigRZ version. The

update instructions are also on our Downloads page next to the TDT Drivers/RPvdsEx https://

www.tdt.com/files/fastfacts/Microcode.pdf.

Software Configuration Changes

For mouse models with the Medusa4Z, you will need to make a few changes to the stock

"Root_ToneABR.acf" file:

From the menu bar click Setup → Acquisition. In the Acquisition Setup screen change

the Source radio button from Bioamp to Medusa4Z and set the drop down menu to 12

kHz. See below indicated by the red arrows.

Immediately  below the Source setup you will  see a  "Chan-1"  button.  Press this  and

change the gain from 20 to 1. See below indicated by the green arrows.

1. 

a. 

b. 
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On the lower left corner of the BioSigRZ screen you can set the Acquisition Filters. In most

cases the best data is found with the following settings:

Once the settings have been edited,  we recommend saving the resulting file  with a new

name,  something  like  "Template_ToneABR.acf"  because  this  file  should  be  used  going

forward as a template for all Tone ABRs for this rig. 

Wrapping up

Before running any subjects with any ABR system, we recommend running a saline test. Only

when the saline test looks good should you proceed to test with a subject. 

2. 

Acquisition Filtering

HP = 300 Hz

LP = 3 kHz

NT = 50 Hz

The NT filter should match the frequency of the mains power coming from your wall. You will see papers from

around the world where this setting will vary. If the RZ6 is moved to a new location, check to be sure the NT

filter is set appropriately based on the frequency of the power being used. 

Note
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Advanced Examples

The standard examples that ship with BioSigRZ cover the most common use case of one

recording channel and one stimulation channel (tone or click).

The examples below are for custom experiments requiring more acquisition channels and/or

more stimulus channels. Choose an appropriate template based on your electrode channels

and stimulation needs. Use the tables below to guide you.

The templates are described in detail, and include a link to the BioSigRZ experiment (*.acf) that

is used. Copy the ACF file into the C:\TDT\BioSigRZ\Configs\ABR  folder so it is available in

BioSigRZ.

Standard Examples for Higher Channel Count

Tone

Medusa4Z Acq Channels Stim Channels Required DSPs ACF Template

1 up to 2 3 Template_Tone_Abr_1CH_Med4Z.acf

* 2 1 3 Template_Tone_Abr_2CH_Med4Z.acf

*† 3 1 4 Template_Tone_Abr_3CH_Med4Z.acf

*† 4 1 4 Template_Tone_Abr_4CH_Med4Z.acf

RA4PA + RA4LI

1 up to 2 3 Template_Tone_Abr_1CH_RA4PA.acf

2 1 3 Template_Tone_Abr_2CH_RA4PA.acf

† 3 1 3 Template_Tone_Abr_3CH_RA4PA.acf

† 4 1 3 Template_Tone_Abr_4CH_RA4PA.acf
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Click

* You must have an RZ6-A-P1 with serial number > 2400 or TDT must have applied ECNs newer

than ECN9322

† Use of the BioSigRZ individual traces is supported with this file.

Fish ABR with Hydrophone

When  using  the  RZ6  with  fish,  customers  generally  want  lower  frequencies  and  slower

presentation  rates  than  commonly  found  with  other  animals  like  rodents.  Additionally

customers typically want to record the stimulus with a Hydrophone at the same time they

record the ABR.

Medusa4Z Acq Channels Stim Channels Required DSPs ACF Template

1 up to 2 3 Template_Click_Abr_1CH_Med4Z.acf

* 2 1 3 Template_Click_Abr_2CH_Med4Z.acf

*† 3 1 4 Template_Click_Abr_3CH_Med4Z.acf

*† 4 1 4 Template_Click_Abr_4CH_Med4Z.acf

RA4PA + RA4LI

1 up to 2 3 Template_Click_Abr_1CH_RA4PA.acf

2 1 3 Template_Click_Abr_2CH_RA4PA.acf

† 3 1 3 Template_Click_Abr_3CH_RA4PA.acf

† 4 1 3 Template_Click_Abr_4CH_RA4PA.acf

File Name Destination

FishFixedPhase.sig C:\TDT\BioSigRZ\SIG\

Medusa

Hydrophone_Med4Z.acf C:\TDT\BioSigRZ\Configs\ABR\

SGRZ_Hydrophone_Med4Z_200K.rcx C:\TDT\BioSigRZ\RCX\

RA4PA

Hydrophone_RA4LI.acf C:\TDT\BioSigRZ\Configs\ABR\

SGRZ_Hydrophone_200K.rcx C:\TDT\BioSigRZ\RCX\
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These examples use FishFixedPhase.sig for presenting typical frequencies used for fish. Users

can make changes to the frequencies if  desired. It  disables the phase variable so that the

stimulus does not alternate, allowing the hydrophone to record the stimulus.

The modified RCX file allows recording from the preamp and the BNC input at the same time.

The hydrophone (connected to In-A on the RZ6) is recorded on channel 1 and the ABR (from

the preamp) is recorded on channel 2 in BioSigRZ.

Calibration can be done with BioSigRZ, however, you must first convert the hydrophone output

to mV/Pa. To determine the mV/Pa output of your hydrophone, please see the equation in Tech

Note TN0828.

Find a closely matching TCF file to your sensitivity in C:\TDT\BioSigRZ\TCF . For example, if

you  determine  the  sensitivity  of  your  hydrophone  is  3.1mV/Pa,  use  3.0mV.tcf  as  your

acquisition TCF during calibration. If your sensitivity does not closely match any of the stock

TCF files provided by TDT please contact support@tdt.com and a custom file can be made for

you.

Once setup is complete, you can follow the standard steps in the BioSigRZ manual for a typical

ABR. The remaining variables (Filters, Acquisition duration, and similar) can be modified as

needed. These modified files will allow you to record both the stimulus and the ABR at the

same time. You will need to manually average the positive and negative responses from each

frequency tested using the calculator functions. From there you can export the data from your

Worksheet if desired.

Users must now manually average the ABR results after the recordings are obtained. This can be done in the

Worksheet or in post-processing. Each frequency will be presented in two consecutive SGIs, once with a positive

phase stimulus, and once with a negative phase.

Note
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Mismatch Negativity (MMN or Oddball)

This  experiment  records  one channel  of  ABR but  presents  two different  stimuli  in  a  user-

defined order and saves the responses in separate channels.

This experiment presents two different stimuli ( Oddball1.sig  and Oddball2.sig ) from Out-A

on the RZ6 based on the order specified in Random_1_2_2000.txt . It records one channel of

ABR data from the preamp, but organizes the averaged responses into two different channels

based on the stimulation that was presented - one for the standard and one for the odd or

deviant.

If you want to change the percentage of Standard vs Odd presentations, change the ratio of 1s

and 2s in the Random_1_2_2000.txt  file. To change the presentation file, open the RCX file and

navigate to the Stim-2  sheet. Change the 'Name' field in the SourceFile component to point to

a different .txt file.

File Name Destination

Oddball1.sig C:\TDT\BioSigRZ\SIG\

Oddball2.sig C:\TDT\BioSigRZ\SIG\

Random_1_2_2000.txt C:\TDT\

Medusa4Z

Oddball_ToneAbr_MED4Z.acf C:\TDT\BioSigRZ\Configs\ABR\

SGRZ_200K_Oddball_Med4Z.rcx C:\TDT\BioSigRZ\RCX\

RA4PA

Oddball_ToneAbr_RA4PARA4LI.acf C:\TDT\BioSigRZ\Configs\ABR\

SGRZ_200K_Oddball_RA4PARA4LI.rcx C:\TDT\BioSigRZ\RCX\

The file path must be under 33 characters and avoid special characters.

Note
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Contralateral Stim with ABR

BioSigRZ can generate stimuli on the contralateral (Out-B) side of the subject during the ABR

recording.  These files are designed to generate continuous Tones,  Noise,  or  Filtered Noise

from the contralateral  speaker as long as BioSigRZ is actively runnin an experiment.  Once

BioSigRZ stops recording, the Contralateral stimulation will stop five seconds later.

There are three examples for this experiment. Examples 1 and 2 below will run on RZ6 units

with three DSPs. Example 3 requires four DSPs.

Contralateral Tones

Users  have  control  of  the  Frequency  and  Intensity  of  the  contralateral  tone  during  the

experiment.

Contralateral Noise

Users have control of the Intensity of the contralateral noise during the experiment.

This five second delay is adjustable. Contact TDT Tech Support support@tdt.com if you need help with this. 

Note

1. 

File Name Destination

TonePip_ContTone.sig C:\TDT\BioSigRZ\SIG\

SGRZ_ContLatTone_200K.rcx C:\TDT\BioSigRZ\RCX\

Medusa4Z

ToneAbr_ContTone_Med4Z.acf C:\TDT\BioSigRZ\Configs\ABR\

RA4PA

ToneAbr_ContTone_RA4PARA4LI.acf C:\TDT\BioSigRZ\Configs\ABR\

2. 

File Name Destination

TonePip_ContNoise.sig C:\TDT\BioSigRZ\SIG\

SGRZ_ContLatNoise_200K.rcx C:\TDT\BioSigRZ\RCX\

Medusa4Z

ToneAbr_ContNoise_Med4Z.acf C:\TDT\BioSigRZ\Configs\ABR\

RA4PA

ToneAbr_ContNoise_RA4PARA4LI.acf C:\TDT\BioSigRZ\Configs\ABR\
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Contralateral Filtered Noise

Users have control of the Intensity and the Low Pass Fc (filter cutoff) and the High Pass Fc

of the contralateral noise.

3. 

File Name Destination

TonePip_ContFiltNoise.sig C:\TDT\BioSigRZ\SIG\

SGRZ_ContLatFilteredNoise_200K.rcx C:\TDT\BioSigRZ\RCX\

Medusa4Z

ToneAbr_ContFiltNoise_Med4Z.acf C:\TDT\BioSigRZ\Configs\ABR\

RA4PA

ToneAbr_ContFiltNoise_RA4PARA4LI.acf C:\TDT\BioSigRZ\Configs\ABR\
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